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Nội dung giới thiệu:

1. Tổng quan về GPS

2. GPSMap 78 & MAPSOURCE
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Nội dung giới thiệu:

1. Tổng quan về GPS

2. GPSMAP 78 & MAPSOURCE
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Tổng quan về GPS

Hệ thống định vị toàn cầu GPS (Global positioning system): do Bộ Quốc phòng Mỹ (U.S Department of 
Defense) khởi xướng, quản lý và phát triển.

Lịch sử: 

- 1973: bắt đầu nghiên cứu 

- 1978: vệ tinh GPS đầu tiên được phóng lên quỹ đạo

- 1993:  24 vệ tinh và đến nay có 32 vệ tinh trên bay trên 6 quỹ đạo

- Trước 1984: GPS chỉ được sử dụng cho  quân sự của Mỹ

- Sau 1984: cho phép sử dụng trong dân sự, nhưng làm nhiễu tín hiệu để 
giảm độ chính xác

- 2000 hủy bỏ việc làm nhiễu
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Tổng quan về GPS

Hệ thống định vị toàn cầu GPS (Global positioning system) 

Cấu trúc: gồm 3 phần (segment)

- Phần không gian (Space segment)

- Phần điều khiển (Control segment)

- Phần sử dụng (User segment)
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Tổng quan về GPS

 Cấu trúc hệ thống GPS: Phần không gian (Space segment)

Gồm: 24 vệ tinh (+ 8 vệ tinh dự phòng) bay xung quanh Trái đất trên 6 quỹ đạo, cách Trái đất khoảng 20 200 km, 
chu kỳ bay 12h

→ mỗi vị trí, tại mọi thời điểm đều quan sát được ít nhất 4 vệ tinh GPS

Nhiệm vụ: phát tín hiệu tới các máy thu GPS để tính toán vị trí máy thu GPS
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Tổng quan về GPS

 Cấu trúc hệ thống GPS: Phần điều khiển (Control segment)

Gồm: 5 trạm điều khiển phân bố đều trên Trái đất

Nhiệm vụ: kiểm soát vệ tinh đi đúng quỹ đạo, xác định vị trí vệ tinh để cung cấp cho vệ tinh và vệ tinh phát 
tới máy thu
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Tổng quan về GPS

 Cấu trúc hệ thống GPS: Phần sử dụng (User segment)

Gồm các thiết bị nhận tín hiệu vệ tinh GPS và người sử dụng phục vụ các mục đích: quân sự, nghiên cứu 
khoa học, dẫn đường, đo đạc trắc địa, khảo sát,…
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Tổng quan về GPS

 Tín hiệu GPS
Các thông tin đạo hàng (vị trí, thời gian, hiệu chỉnh khí 
quyển,… của vệ tinh)

→ mã hóa (C/A code, P code)

→ phát tới máy thu qua 2 sóng tải:
 L1 (1575.42MHz)
 L2 (1227.6 MHz)
(Ngoài ra còn song L3, L4, L5 được sử dụng cho mục 
đích khác)
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Tổng quan về GPS

 Các nguồn sai số GPS

- Sai số quỹ đạo vệ tinh

- Sai số đồng hồ vệ tinh

- Độ trễ tầng đối lưu, tầng khí quyển

- Đa đường dẫn

- Sai số do máy thu GPS

Lưu ý: hiện tượng đa đường dẫn do máy thu đặt gần các công trình, địa vật,… làm nhiễu, che chắn, phản xạ tín 
hiệu GPS
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Tổng quan về GPS

 Nguyên lý định vị GPS
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Định vị tuyệt đối: ഥR = ҧr − തρ

→ cần tối thiểu 4 vệ tinh để xác định (X,Y,Z) của 1 điểm 
→ sử dụng 1 máy thu GPS
ĐCX: 3-30m

Định vị tương đối: 𝛥 ത𝑅 = ҧ𝜌1 − ҧ𝜌2

→ 2 điểm thu chung đồng thời tối thiểu 4 vệ tinh để xác định 
(ΔX, ΔY, ΔZ) giữa 2 điểm
→ sử dụng 2 máy thu GPS
ĐCX: mm/nghìn km

Định vị tuyệt đối được sử dụng rộng rãi trong các công việc hàng ngày: dẫn đường, xác định vị trí các điểm đo,…

Máy thu GPS tuyệt đối
Máy thu GPS tương đối
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Tổng quan về GPS

 Hệ tọa độ dung trong GPS: WGS84

Ellipsoid tham chiếu WGS84
Tâm O trùng với trọng tâm Trái đất
Trục X: đi qua giao điểm xích đạo – kinh tuyến gốc 
Trục Z: trùng với trục quay Trái đất

Vị trí của 1 điểm đo bằng GPS: XYZ (hoặc BLH) trong hệ WGS84

Tâm hệ WGS84 (quốc tế) lệch với tâm hệ VN2000 (Việt Nam):

 - Dx= - 192 m
 - Dy=   - 39 m
 - Dz= - 111 m
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Tổng quan về GPS

 Các ứng dụng của GPS trong dân sự:

- Quản lý, dẫn đường ôtô, tàu thủy, máy bay,… 

(GPS navigator)

- Giám sát, theo dõi (GPS tracker)

- Khảo sát trắc địa, bản đồ

(GPS surveying, mapping)

- Xác định chuyển dịch vỏ Trái đất (GPS network)

  …
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Nội dung giới thiệu:

1. Tổng quan về GPS

2. GPSMAP 78 & MAPSOURCE
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GPSMap 78
 & Phần mềm Mapsource
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GPSMap 78

Tổng quan:

Hãng Garmin – Mỹ (http://www.garmin.com/en-US)

Chức năng chính: - định vị tuyệt đối
                              - dẫn đường
                              - tìm kiếm vị trí
                              …

Độ chính xác vị trí điểm tuyệt đối từ 1-5 m

http://www.garmin.com/en-US
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GPSMap 78

Các phím chức năng
Ấn + giữ: tắt / mở 

FIND/MOD:      Ấn: mở chức năng tìm kiếm
                            Ấn + giữ (MOB): lưu điểm hiện tại và tìm điểm khác
PAGE:                 Chuyển trang khác

MENU:               Ấn 1 lần: vào lựa chọn chức năng trang hiện tại
                            Ấn 2 lần: vào trang chức năng chính
ENTER/MARK: Ấn: lựa chọn
                            Ấn + giữ (MARK): lưu điểm hiện tại

+ / - :                   Phóng to, thu nhỏ bản đồ

QUIT:                 Thoát khỏi trang hoặc chức năng hiện tại

Điều hướng để chọn menu/vị trí bản đồ
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GPSMap 78

Các màn hình chính: Màn hình vệ tinh (Satellite)

Ðây là màn hình đầu tiên nên tham khảo truớc khi sử dụng máy:
    - Ấn MENU 2 lần → Menu chính 
    - Chọn Satellite > ENTER
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GPSMap 78

Các màn hình chính: Màn hình bản đồ (Map)

Định hướng bản đồ (Orientation):

- Từ màn hình bản đồ, ấn MENU 1 lần 

- Chọn Setup Map > Orientation

- Chọn:
 + North Up: hướng bắc là đỉnh bản đồ
 + Track Up: hướng đang đi là đỉnh bản đồ
 + Automotive Mode: nhìn toàn cảnh.
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GPSMap 78

Các màn hình chính: Màn hình bản đồ (Map)

Gắn la bàn vào bản đồ (Compass):

- Từ màn hình bản đồ, ấn MENU 1 lần 

- Chọn Setup Map > Map > ENTER

- Chọn Data Fields > Dashboard > Compass > ENTER 

(Ðể gỡ bỏ la bàn:
  Chọn Setup > Map > Datafields > 0 > ENTER )
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GPSMap 78

Các màn hình chính: Màn hình la bàn (Compass)

Màn hình la bàn dùng dể dẫn đuờng, mũi tên ▲ là hướng cần đi đến
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GPSMap 78

Cài đặt trước khi sử dụng: đơn vị đo

1. Ấn 2 lần MENU → Menu chính

2. Chọn Setup > Units

 - Distance and Speed (khoảng cách & vận tốc) :
    chọn Metric
 - Elevation (Vertical Speed) (độ cao & vận tốc) :
    chọn Meters (m/s)

 - Depth (độ sao) : chọn Meters

- Tempareture (nhiệt độ) : chọn Celsius

- Pressure (áp suất) : chọn Millibars
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GPSMap 78

Cài đặt trước khi sử dụng: hiển thị tọa độ

1. Ấn 2 lần MENU → Menu chính

2. Chọn Setup > Position Format

 - Chọn hddd’mm.mmm’ : nếu muốn xem tọa độ 
duới dạng dộ, phút, giây (tọa độ trắc địa BLH)

 - Chọn UTM UPS : nếu muốn xem tọa độ duới 
dạng mét (tọa độ vuông góc XYZ)
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GPSMap 78

Cài đặt trước khi sử dụng: hệ tọa độ VN2000

1. Ấn 2 lần MENU → Menu chính

2. Chọn Setup > Position Format
    - Chọn Map Datum > User
    - Nhập ΔX, ΔY, ΔZ: ΔX = -00192, ΔY = -00039, ΔZ = -00111
    - Ấn QUIT để thoát

3. Position Format > User Grid > UTM
 - False Easting : Ðổi giá trị thành 500000.0m
 - False Northing: Ðổi giá trị thành 0.0m
 - Scale: Đổi giá trị thành +0.9996000 (hoặc +09999000)
 - Longitude Origin: đổi W → E, nhập giá trị kinh tuyến 
trục địa phương (Quảng Bình 106 0.000) 
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GPSMap 78

Các chức năng thông dụng: Waypoint
1. Đo & lưu tọa độ 1 điểm (waypoint) 
- Khởi động máy 2-5’ → thu ổn định tín hiệu vệ tinh
- Ấn ENTER/MARK  (tại bất kỳ trang nào) để lưu điểm đo (máy lưu được 2000 điểm)
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GPSMap 78

Các chức năng thông dụng: Waypoint
2. Nhập tọa độ của một điểm vào máy

- Nhấn và giữ phím Mark

- Chọn Location>ENTER → Nhập tọa độ vĩ độ, kinh độ

- Nhập xong, chọn Done

Muốn xem điểm này trên bản đồ, chọn Map,  Nếu không,
nhấn Quit để thoát
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GPSMap 78

Các chức năng thông dụng: Waypoint
3. Đo tọa độ 1 điểm trên bản đồ lưu trong máy

- Ấn Page hoặc Quit → chọn màn hình Map

- Ấn + hoặc – để phóng/thu bản đồ

- Ấn           (Rocker) để di chuyển con trỏ đến vị trí cần đo

- Ân ENTER, trên màn hình sẽ hiện: tọa độ, cao độ, khoảng 
cách

- Ấn MENU, Chọn Save As Waypoint > OK để lưu tọa độ
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GPSMap 78

Các chức năng thông dụng: Waypoint
4. Chỉnh sửa, xóa các điểm đo

Xóa 1 điểm waypoint:

- Ấn MENU 2 lần → Menu chính, chọn Waypoint Manager

-  Chọn 1 waypoint cần xóa, ấn ENTER

- Ấn MENU 1 lần, chọn Delete

Xóa toàn bộ điểm waypoint:

Ấn MENU 2 → Menu chính, chọn Setup > Reset > Delete All Waypoints > Yes 
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GPSMap 78

Các chức năng thông dụng: Waypoint
4. Chỉnh sửa, xóa các điểm đo

Chỉnh sửa 1 điểm waypoint:

- Ấn MENU 2 lần → Menu chính, chọn Waypoint Manager

-  Chọn 1 waypoint cần chỉnh sửa, ấn ENTER

- Thay đổi thuộc tính: tên (name), biểu tượng (symbol), độ cao (elevation),…

- Chọn Done để kết thúc
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GPSMap 78

Các chức năng thông dụng: Waypoint
5. Đo khoảng cách giữa 2 điểm trên bản đồ

- Ấn PAGE hoặc QUIT → chọn màn hình Map

- Ấn + hoặc – để phóng/thu bản đồ

- Ấn           (Rocker) để di chuyển con trỏ đến điểm thứ nhất

- Ấn MENU 1 lần, chọn Measure Distance

- Dùng phím Rocker di chuyển con trỏ đến điểm khác, sẽ 
được khoảng cách cần đo
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GPSMap 78

Các chức năng thông dụng: Waypoint
5. Đo khoảng cách giữa điểm đang đứng & điểm khác

- Ấn PAGE hoặc QUIT → chọn màn hình Map

- Ấn MENU 1 lần, chọn Measure Distance

- Dùng phím Rocker di chuyển con trỏ dến điểm thứ 2, sẽ được khoảng cách cần đo

* Có thể đo khoảng cách từ vị trí hiện tại → tất cả các điểm Waypoint đã luu:

- Ấn MENU 2 lần → Menu chính 

- Chọn Waypoint Manager, sẽ thấy duới mỗi Waypoint là khoảng cách, hướng đến Waypoint đó 
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GPSMap 78

Các chức năng thông dụng: tìm điểm
1. Tìm 1 điểm đã lưu trong máy

- Từ trang màn hình bất kỳ, nhấn FIND

- Chọn Waypoints

- Chọn 1 waypoint cần tìm (cần đi đến)

- Chọn Go

Khi đến nơi, máy sẽ thông báo 1 tiếng “bíp” + dòng chữ Arriving At …

Ðể dừng, ấn FIND  > Stop Navigation
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GPSMap 78

Các chức năng thông dụng: tìm điểm
2. Tìm 1 điểm mới nhập tọa độ

- Từ trang màn hình bất kỳ, nhấn FIND > Coordinate > ENTER

- Nhập tọa độ điểm cần tìm,  chọn Done > ENTER
   Máy sẽ chuyển sang màn hình bản đồ với tuyến đường cần đi

Ðể dừng, ấn FIND  > Stop Navigation
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GPSMap 78

Các chức năng thông dụng: đo diện tích (Area)

- Ấn MENU 2 lần → Menu chính, chọn Area Calculation > Start
- Ði vòng quanh khu vực cần đo, chọn Calculate khi đi đến điểm cuối cùng (cũng là điểm xuất phát)
Sau đó, nên chọn Save Track để luu lại. Chọn Change Units để đổi đơn vị đo diện tích. Tắt máy sau khi đo.
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GPSMap 78

Các chức năng thông dụng: đo diện tích (Area)

Xem lại chu vi, diện tích của của một lô đất đã đo:

- Ấn MENU 2 lần → Menu chính, chọn Track Manager

- Chọn 1 Track từ danh sách mà bạn muốn xem

- Chọn View Map

- Ấn MENU 1 lần

- Chọn Review Track để xem chu vi, diện tích đo được
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GPSMap 78

Các chức năng thông dụng: Route (hành 
trình)

Hành trình là một chuỗi điểm waypoint, nó dẫn đi từ điểm 
đầu đến điểm cuối (lưu đuợc 50 hành trình, 250điểm/1 hành 
trình)
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GPSMap 78

Các chức năng thông dụng: Route (hành trình)
Thiết lập 1 hành trình (Route planner):

- Ấn MENU 2 lần → Menu chính, chọn Route Planer > Create Route > First Point

- Chọn diểm đầu hành trình: chọn Waypoints,  chọn 1 waypoint, nhấn ENTER

- Chọn Use

- Chọn Select Next Point, ….

- Ấn QUIT để luu lại hành trình

(Có thể thay đổi, chỉnh sửa các hành trình đã thiết lập)
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GPSMap 78

Các chức năng thông dụng: TRACK (giám 
sát đường đi)

GPSMap sẽ ghi lại vết, đường đi (Track log) trong quá trình 
di chuyển. Có thể lưu lại những track này và sử dụng sau đó
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GPSMap 78

Các chức năng thông dụng: TRACK (giám sát đường đi)

1. Cài đặt Track log:

- Ấn MENU 2 lần → Menu chính, chọn Setup > Tracks > Tracks Log 

- Chọn Record, Do Not Show (ghi đường đi, không hiển thị trên bản đồ)
             hoặc Record, Show On Map (ghi đường đi, hiển thị trên bản đồ)
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GPSMap 78

Các chức năng thông dụng: TRACK (giám sát đường đi)

2. Xem Track (đường đi) hiện tại:

- Ấn MENU 2 lần → Menu chính, chọn Track Manager > Current Track

-  Chọn:  + View Map : hiển thị đường đi trên bản đồ
                + Hoặc Elevation Plot : hiển thị biểu đồ cao độ của đường đi (trắc dọc tuyến)
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GPSMap 78

Các chức năng thông dụng: TRACK (giám sát đường đi)

2. Lưu, xóa Track (đường đi):

Lưu 1 đường đi:
- Ấn MENU 2 lần → Menu chính, chọn Track Manager > Current Track
- Chọn : + Save Track : lưu lại toàn bộ đường đi
               + Hoặc Save Portion: lưu lại một đoạn của đường đi

Xóa đường đi hiện tại:
- Ấn MENU 2 lần → Menu chính, chọn Setup > Reset  > Clear Current Track > Yes

Xóa 1 đường đi đã lưu:
   - Từ Menu chính, chọn Track Manager
   - Chọn track cần xóa, nhấn ENTER > Delete > Yes
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Mapsource
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Mapsource

Mapsource  là phần mềm đi kèm thiết bị thu GPSMap của Garmin, 
mục đích:

- Quản lý bản đồ, dữ liệu địa lý,…

- Lên kế hoạch di chuyển 

- Nhập, chỉnh sửa, xem các điểm, các đường đi,…

- Nhập, trút dữ liệu máy thu GPS → máy tính
   …

Bộ cài kèm đĩa CD hoặc download tại: 
http://www8.garmin.com/support/download_details.jsp?id=209 

http://www8.garmin.com/support/download_details.jsp?id=209
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Mapsource

Thiết lập hệ thống Mapsource: chọn đơn vị, hệ tọa độ,… phù hợp với cài đặt của máy thu GPSMap

Chọn Edit > Preferences....
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Mapsource

Thiết lập hệ thống Mapsource: chọn đơn vị, hệ tọa độ,… phù hợp với cài đặt của máy thu GPSMap

Chọn đơn vị đo như trên
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Mapsource

Thiết lập hệ thống Mapsource: chọn đơn vị, hệ tọa độ,… phù hợp với cài đặt của máy thu GPSMap

Chọn lưới chiếu tọa độ: Position → Grid chọn User Defined 
Grid > Properties… 
        (chọn các tham số như trên cho khu vực Quảng Bình)
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Mapsource

Thiết lập hệ thống Mapsource: chọn đơn vị, hệ tọa độ,… phù hợp với cài đặt của máy thu GPSMap

Chọn hệ tọa độ: Position → Datum chọn User Defined Grid 
> Properties… 
        (chọn các tham số như trên cho VN2000)
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Mapsource

Trao đổi dữ liệu PC – GPSMap qua Mapsource

- Kết nối máy GPSMap với PC bằng cable đi 
kèm

- Mở ứng dụng Mapsource trên PC 

- Mở máy GPSMap
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Mapsource

Trao đổi dữ liệu PC – GPSMap qua Mapsource
1. Trút dữ liệu từ máy GPSMap → PC

- Chọn Transfer > Receive From Device hoặc biểu tượng

- Tại hộp thoại Receive 
From Device: đánh dấu 
tuỳ chọn
WayPoints, Tracks, Maps, 
Routes, xong nhấp 
Receive
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Mapsource

Trao đổi dữ liệu PC – GPSMap qua Mapsource
1. Trút dữ liệu từ máy GPSMap → PC

Quá trình trút dữ liệu kết thúc:

Các điểm 
waypoints

Số lượng các hành 
trình (routes), các 
đường (tracks), các 
bản đồ (maps), các 
điểm (waypoints) 
đã trút
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Mapsource

Trao đổi dữ liệu PC – GPSMap qua Mapsource
2. Trút dữ liệu từ PC →  máy GPSMap

- Chọn Transfer > Send to Device hoặc biểu tượng
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Mapsource

Trao đổi dữ liệu PC – GPSMap qua Mapsource
3. Xuất dữ liệu sang GIS, Autocad

Mapsource kết xuất dữ liệu sang các 
khuôn dạng khác như cho Autocad 
(*dxf), GIS (*gdb),…

- Chọn File > Save as…

- Lựa chọn khuôn dạng DL cần kết 
xuất
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Bài tập thực hành

1. Đo tọa độ các điểm hố ga bằng GPSMap78

2. Đo tuyến cống bằng GPSMap78

3. Tìm hố ga đã biết tọa độ bằng GPSMap78

4. Trút dữ liệu qua lại PC - GPSMap78
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